
 

 
www.geoscan.aero 

ГИС СПУТНИК 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

ГИС СПУТНИК 
версия 1.0 

 
 
 
 
 
 

Руководство 

пользователя 
  



 
 
 

 

ГИС СПУТНИК 

www.geoscan.aero 

 
 

Оглавление 

Общие сведения .......................................................................................................................................... 3 

Установка и запуск программы .................................................................................................................. 3 

Системные требования ........................................................................................................................... 3 

Установка программы ............................................................................................................................. 4 

Начало работы ............................................................................................................................................. 4 

Демонстрационные примеры .................................................................................................................... 6 

Подключение ортофотоплана и цифровой модели местности, полученных в Agisoft Photoscan ... 6 

Экспорт данных из Agisoft Photoscan ................................................................................................. 6 

Подключение ортофотоплана и DEM  в Спутнике ............................................................................ 8 

Инструменты измерения в Спутнике ............................................................................................... 10 

Подключение 3D моделей, полученных в Agisoft Photoscan ............................................................ 13 

Подключение данных по протоколу WMS .......................................................................................... 15 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

©GeoScan, 2013 



 
 
 

 

ГИС СПУТНИК 

www.geoscan.aero 

Общие сведения 

Спутник это современная трехмерная геоинформационная система, представляющая 
собой виртуальный глобус, обеспечивающая ситуационную осведомленность оператора и 
реализующая стандарты  Open Geospatial Consortium (OGC). 

Спутник предназначен для работы с ортофотопланами и цифровыми моделями 
местности, полученными из Agisoft PhotoScan Pro. 

 

 
 
Теперь вы сможете работать со своими данными в географической информационной 

системе. ГИС Спутник позволяет загружать цифровые модели местности, полученные в 
Agisoft Photoscan и работать с неограниченными по размеру ортофотопланами и 
цифровыми моделями местности. Базовое покрытие на поверхность Земли, а также 
поддержка стандартов OGC, позволяет загружать данные в единое геоинформационное 
пространство. Поддержка протокола WMS позволяет подключать данные с OGC-
совместимых серверов.   Основной формат ГИС Спутник – KML, открывает широкие 
возможности по визуализации трехмерных объектов и данных в режиме реального 
времени.  

Данное руководство содержит демонстрационные примеры в объеме, необходимом 
для ознакомления с возможностями системы.  

Все свои отзывы, рекомендации и пожелания по работе ГИС Спутник 1.0 просим 
направлять на электронный адрес: sputnik@geoscan.aero  

Установка и запуск программы 

Системные требования 

 ОС: Windows XP, 7, 8 (32-bit or 64-bit) 

 1 Гб дискового пространства (для хранения файлов приложения и кэша данных) 

 2 Гб RAM 

 Видеоадаптер: Nvidia, ATI/AMD, Intel HD 4000, 1Gb VRAM 

mailto:sputnik@geoscan.aero
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Установка программы 

 Перейдите на страницу загрузки http://www.geoscan.aero/ru/sputnik и скачайте ГИС 
Спутник 1.0 

 Следуйте инструкциям на экране для завершения установки программного 
обеспечения. Установщик зарегистрирует на ГИС Спутник файлы *.kml и *.kmz 

 Для запуска программы выберите в меню Пуск   

 

Начало работы 

После запуска отобразится окно Спутник:  

 

 

http://www.geoscan.aero/ru/sputnik
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Интерфейс пользователя ГИС Спутник состоит из картографического окна (1), пунктов 

меню (2), панели инструментов (3), окна «Maps» (4), а также окна Properties (5). 
По умолчанию в картографическом окне ГИС Спутник отображаются базовые покрытия 

поверхности Земли спутниковыми снимками Landsat и модель рельефа по данным Shuttle 
radar topographic mission (SRTM). 

Для навигации по карте используйте мышь и клавиатуру: 

Операция  Действие пользователя 

Приближение/удаление или изменение 
масштаба отображения 

- Вращайте колесико мыши вперед/назад 
- кнопки «+»/ «-» на клавиатуре 

Перемещение  - удерживая левую кнопку мыши 
«сдвиньте» карту в требуемом направлении 

- курсорными клавишами 

Выбор произвольного ракурса и угла 
просмотра  

- удерживая правую кнопку мыши, 
переместите  к себе/от себя – изменит 
вертикальный угол просмотра, влево/право 
– вращение по/против часовой стрелки 

- комбинация SHIFT+курсорные кнопки 
«вверх»/ «вниз» - изменение вертикального 
угла просмотра, «влево»/ «вправо» - 
вращение по/против часовой стрелки 

Ориентация карты на север и 
восстановление положения камеры в надир  

- нажмите кнопку «R» 
 

Ориентация на север - нажмите кнопку «N» 
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Демонстрационные примеры 

Раздел содержит описание возможностей ГИС Спутник по подключению и работе с 
различными типами геопространственных данных. 

Подключение ортофотоплана и цифровой модели местности, полученных 
в Agisoft Photoscan 

Описание 
Демонстрация показывает возможности в Спутнике подключать ортофотопланы и 

цифровые модели местности, созданные в ПО Photoscan Pro.  
ПО Photoscan Pro предназначена для автоматического создания высокоточных 

геопривязанных 3D-моделей объектов, истинных ортофотопланов и матриц высот по 
данным аэрофотосъемки http://www.agisoft.ru/ 

Реализованные алгоритмы формирования изображения в ГИС Спутник позволяют 
отображать ортофотопланы и DEM (Digital Elevation Model) неограниченно больших 
размеров.  При этом данные загружаются по мере необходимости в нужном разрешении.  
 

Экспорт данных из Agisoft Photoscan 

Для визуализации своих данных в Спутнике необходимо из Agisoft Photoscan 
выполнить экспорт ортофотоплана и DEM в формате KMZ.  

Для этого: 

  Должна быть установлена версия Agisoft PhotoScan Pro не ниже 0.9.1 build 1703 
(http://www.agisoft.ru/products/photoscan/professional/demo/PhotoScan) 

 Для включения функции экспорта DEM в формате KMZ в  Agisoft Photoscan Pro в  
меню Tools > Preferences включите пункт «Enable experimental file formats» 
 

 

http://www.agisoft.ru/
http://www.agisoft.ru/products/photoscan/professional/demo/PhotoScan
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 Выполните экспорт ортофотоплана из Photoscan Pro в меню File > Export Orthophoto > 
Export Google KMZ: 

 

Полученный ортофотоплан можно просматривать в геобраузере с поддержкой KML, в т.ч. 

в Google Earth. 

 Настройте параметры экспорта и нажмите Export: 

 

  

 Выполните экспорт DEM из Photoscan Pro в меню File > Export DEM > Export Sputnik 
KMZ: 
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Специально для хранения мозаики DEM фирмой Geoscan совместно с Agisoft было 
разработано расширение стандарта KML.  

 

 Настройте параметры экспорта DEM и нажмите Export: 
 

 

 

Подключение ортофотоплана и DEM  в Спутнике 

 Используйте свои данные или скачайте готовый набор данных из Photoscan по 
адресу: ftp://public:public@ftp.plaz.aero/public/Sputnik_demo/orthophoto_and_DEM.zip 
(118 Мб). 

 Распакуйте архив. 

ftp://public:public@ftp.plaz.aero/public/Sputnik_demo/orthophoto_and_DEM.zip
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 Откройте ортофотоплан: 
orthofoto_and_DEM/quarry_sensefly_orto_27mm_mosaic/Switzerland_ortho.kml в 
Спутнике через Меню > Import Maps > KML: 

 

 

 

 В списке слоев данных выберите Switzerland_ortho.kml и двойным щелчком мыши 
перейдите к ортофотоплану. 

 При помощи чекбоксов справа от названий слоев и элементов, можно отключать и 
включать их отображение. 

 Увеличьте масштаб отображения: 

 

 
По умолчанию ортофотоплан совместится с текущим рельефом SRTM в Спутнике. 

Рельеф SRTM имеет пространственное разрешение 90 м и разрешение по высоте 1 м.  Для 
просмотра рельефа с высоким разрешением загрузите локальную цифровую модель 
местности:  
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 Аналогично подключению ортофотоплана,  откройте цифровую модель местности 
в Спутнике: 
orthofoto_and_DEM/quarry_sensefly_DEM_90mm/sensfly_Switzerland_DEM.kml  

 

 

Теперь вы можете видеть ортофотоплан совместно с локальной цифровой моделью 
местности.  

Используя средства навигации Спутника можно передвигаться по карьеру, в том числе 
на уровне Земли.  

 

Инструменты измерения в Спутнике 

 

Для измерений высоты, длины поверхности, диаметров отвалов можно использовать 
доступные инструменты «Линейка» и «Циркуль».  

Инструмент измерения расстояний  
Инструмент «Линейка» работает в двух режимах: с привязкой к рельефу и без 

привязки. Для настройки режима необходимо в меню Инструменты > Настройки 
отметить, либо снять отметку Привязка к рельефу. 
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Для измерения расстояния выберите на панели инструментов инструмент «Линейка» и 

укажите начальную и конечную точку на поверхности. В результате будет получено 

кратчайшее расстояние между точками с учетом рельефа: 
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и без учета рельефа: 

 

Дополнительно можно передвигать узловые, начальные и конечные точки измерений 

на поверхности и отслеживать изменения значений расстояния между этими точками. 

Для этого наведите курсор на одну из точек, она подсветится, после чего начинайте 

передвигать точку по поверхности, зажав левую кнопку мыши.  

Для прекращения измерений нажмите правую кнопку мыши. 
 
Инструмент измерения радиуса  
Для измерения радиуса необходимо: 

 Выбрать инструмент  на панели инструментов 

 Левой клавишей мыши поставить на карте точку, которая будет центром 
окружности. 

 Нажав на появившийся синий квадратик и удерживая левую кнопку мыши, 
изменять размер окружности. 

 Для перемещения окружности наведите курсор на центр окружности, зажмите 
левую кнопку мыши и начинайте перемещение 
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Подключение 3D моделей, полученных в Agisoft Photoscan 

Описание  
Демонстрация показывает возможность Спутника помимо ортофотопланов и DEM, 

открывать геопривязанные 3D модели, полученные в Photoscan. В демонстрации 
используются 3D модели  зданий, которые являются объектами культурного наследия 
регионального значения (комплекс зданий молочной фермы Юлия Бенуа ) в Санкт-
Петербурге, подлежащих реконструкции. 3D модели зданий получены по результатам 
фотосъемки с коптера (многороторного вертолета) сотрудниками компании Геоскан. 

 
 Подготовка  

Скачайте набор данных (13 Мб) по ссылке 
ftp://public:public@ftp.plaz.aero/public/Sputnik_demo/house_3D.zip. 

 
Демонстрация 
 
Через меню Карта > KML загрузите файл house_1.kmz. Для просмотра модели дважды 

кликните по загруженному файлу в окне «Карта»: 
 

 

ftp://public:public@ftp.plaz.aero/public/Sputnik_demo/house_3D.zip
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Для просмотра объекта используйте средства навигации Спутника. 
Аналогичным образом подгрузите второе здание house_2.kmz, стоящее рядом. 
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Вы также можете подключить «нарисованные» 3D модели с таких ресурсов, как 

3dwarehouse (http://www.sketchup.com/products/3D-warehouse).  
Например: 

  зайдите по ссылке:  
http://sketchup.google.com/3dwarehouse/details?mid=be26635c5be9f21b9b9685fd76f6c85&prevs
tart=0 

 Выберите Download Model > Google Earth 4 (.kmz) 

 Сохраните файл schloss-neuschwanstein.kmz к себе на компьютер 

 Загрузите 3D модель в Спутник: 
 

 

 

Подключение данных по протоколу WMS 

 
Описание  
Демонстрация показывает возможность просматривать карты с различных серверов в 

сети Интернет по протоколу WMS ( http://en.wikipedia.org/wiki/Web_Map_Service), в том 
числе карты OpenStreetMap, спутниковые снимки 

 Подготовка  
 Убедитесь в наличии скоростного доступа к сети Интернет  

 Убедитесь, что сайт http://irs.gis-lab.ru/?VERSION=1.1.1 доступен  
 
Демонстрация 
 
Откройте меню Импорт > WMS:  
 
 Введите адрес доступного WMS сервера, например  http://irs.gis-lab.info/:  

http://www.sketchup.com/products/3D-warehouse
http://sketchup.google.com/3dwarehouse/details?mid=be26635c5be9f21b9b9685fd76f6c85&prevstart=0
http://sketchup.google.com/3dwarehouse/details?mid=be26635c5be9f21b9b9685fd76f6c85&prevstart=0
http://ru.wikipedia.org/wiki/WMS
http://ru.wikipedia.org/wiki/WMS
http://irs.gis-lab.ru/?VERSION=1.1.1
http://irs.gis-lab.info/
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Двойным щелчком в левом списке выберите требуемый слой (например, «OpenStreetMap 

mapnik»):  
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Вы также можете выбрать несколько слоев для отображения. Для этого необходимо, 
удерживая Ctrl, выбрать нужные слои и перенести их в левый список с использованием  

кнопки : 
  

 

 
Нажмите Finish, в результате слой добавится в окно «Maps» и по умолчанию будет 

включен.  
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В случае добавления нескольких слоев в окне «Слои и объекты» будет сформирована 

группа: 

 

 
Для управления видимостью слоев необходимо снять/поставить галочку рядом с 

названием слоя. 
Для того чтобы изменить порядок расположения слоев как внутри группы, так и любых 

других доступных слоев и объектов, необходимо внутри окна «Слои и объекты»  с 
нажатой левой кнопкой мыши «перетащить» слой или объект выше или ниже исходного 
местоположения.    

Таким образом, могут быть подключены геоданные с любых OGC совместимых 
серверов, например, с ArcGIS Server, Geoserver (www.geoserver.org ) и т.д.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
По вопросам приобретения ГИС Спутник, технической поддержки, обращайтесь по  e-mail 

spunik@geoscan.aero 
 
Geoscan team, 194021, Russia, Санкт-Петербург, ул. Шателена, д. 26А, телефон: 8 (812) 363-33-

62,  www.geoscan.aero 
 

http://www.geoserver.org/

